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Глава 1. 
Предварительная информация о MPLAB-ICD 

 
 

1.1 Введение. 
 
Этот раздел дает Вам предварительную информацию о Внутрисхемном 
отладчике MPLAB-ICD (In-Circuit Debugger), его особенностях, функциях, а также 
его аппаратных и программных элементах. 

 

1.2 Основные моменты. 
 

Темы, освещенные в этой главе: 
 

• Что такое MPLAB-ICD. 
• Как MPLAB-ICD Помогает Вам. 
• Ресурсы, используемые MPLAB-ICD. 
• Компоненты MPLAB-ICD. 
• Интегрированная среда обработки MPLAB (Integrated Development Environment - 

IDE). 
• Инструментальные средства разработки MPLAB. 

 

1.3 Что такое MPLAB-ICD. 
 
MPLAB-ICD - недорогой оценочный комплект для микроконтроллеров серии 
PIC16F87x. Используя возможность внутрисхемной отладки (ICD), встроенную в 
кристаллы PIC16F87x, а также протокол внутрисхемного последовательного 
программирования фирмы Microchip (ICSP�), MPLAB-ICD - является 
программатором и внутрисхемным отладчиком одновременно. Он работает под 
управлением Интегрированной Среды разработки MPLAB IDE, подключается к 
Отлаживаемому Устройству и работает как микроконтроллер PIC16F87x. 
MPLAB-ICD специально предназначен для использования как помощи при 
ознакомлении и отладке кода в составе лаборатории. 
 
MPLAB-ICD обеспечивает: 
 

• Пошаговое выполнение кода в реальном масштабе времени. 
• Точки останова (breakpoints). 
• Внутрисхемная отладка. 
• Встроенное программирование. 
• Диапазон рабочих напряжений от 3.0V до 5.5V. 
• Работа от источника питания отлаживаемой схемы. 
• Рабочие частоты от 32 кГц до 20 МГЦ. 
• Отладка по исходному коду и Символическим именам. 
• Интерфейс пользователя MPLAB. 
• Совместимость с Microsoft Windows® 3. x, Windows 95/98, Windows NT®, и 

Windows 2000®. 
• RS-232 Интерфейс. 
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1.4 Как помогает MPLAB-ICD. 
 

MPLAB-ICD позволяет Вам: 
 

• Отлаживать ваш исходный код в вашем собственном приложении. 
• Отлаживать вашу аппаратную часть в реальном масштабе времени. 
• Программировать используемый в отлаживаемом устройстве PIC16F87x, 
используя протокол внутрисхемного программирования ICSP от компании 
Microchip. 

 

1.5 Ресурсы, используемые MPLAB-ICD. 
 

Используя функцию Внутрисхемной Отладки (ICD), встроенную в кристаллы 
PIC16F87X и функцию Внутрисхемного Последовательного Программирования 
(ICSP) обеспечиваемые отладчиком, MPLAB-ICD будет использовать 
следующие ресурсы отлаживаемого кристалла: 
 

• MCLR/VPP используется Отладчиком для программирования. 
• Функция Низковольтного Внутрисхемного Программирования (Low-voltage 

Programming) - отключена. 
• Выводы RB6 и RB7 зарезервированы для программирования и Внутрисхемной 
Отладки. 

• Шесть регистров RAM зарезервированы для Отладчика (см. ниже). 
• Самой первой инструкцией, расположенной по адресу 0x0000 должна быть 
инструкция NOP. 

• Последние 256 или 288 слов области Памяти Программ резервируются для 
Кода Отладки (в зависимости от кристалла, см. ниже). 

• Отладчик использует для своих целей Один уровень стека. 
 
Память Данных и Программ, используемая MPLAB-ICD: 
 
MPLAB-ICD использует следующие регистры RAM и ячейки Памяти Программ в 
отлаживаемом PIC16F87x: 

 
Процессор Файловые регистры Память Программ 
PIC16F870/871/872 0x70, 0x0BB...0x0BF 0x06E0...0x07FF 
PIC16F873/874 0x70, 0x0EB...0x0F0 0x0EE0...0x0FFF 
PIC16F876/877 0x70, 0x1EB...0x1EF 0x1F00...0x1FFF 
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1.6 Компоненты MPLAB-ICD. 
 
MPLAB-ICD содержит четыре основных компонента: 

1. Модуль MPLAB-ICD. 
2. Переходник MPLAB-ICD. 
3. Демонстрационная плата MPLAB-ICD. 
4. Программное обеспечение MPLAB-IDE (для PC). 

 

 
Рис. 1.1 Компоненты MPLAB-ICD. 
 

 
Рис. 1.2 Модуль MPLAB-ICD подключенный непосредственно к 
Демонстрационной плате (без переходника). 

 
1.6.1 Модуль MPLAB-ICD. 

 
Модуль MPLAB-ICD содержит всю необходимую логику для отладки, 
программирования и  управления. Он подключается к последовательному порту 
Персонального Компьютера через 9-проводный кабель и к отлаживаемой плате 
через 6-контактный модульный разъем. Если отлаживаемая плата не имеет 6-
контактного модульного разъема (пункт 12 в разделе 1.6.3), модуль может быть 
подключен через Переходник (header) MPLAB-ICD. 
 
Модуль MPLAB-ICD содержит PIC-контроллер PIC16F876 с прошивкой, 
обеспечивающей последовательную связь между компьютером и 
микроконтроллером, находящимся в Отлаживаемой плате и его внутрисхемное 
программирование по протоколу ICSP. Все это производится под управлением 
Интегрированной Среды Разработки MPLAB. Модуль питается от напряжения 
питания отлаживаемой платы и требует 70 мА (максимально) потребляемого 
тока. 
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Модуль MPLAB-ICD может быть подключен: 
 

• К Переходнику MPLAB-ICD, который устанавливается в панель Отлаживаемой 
платы вместо микроконтроллера. 

• К контактам разъёма, расположенного на Отлаживаемой плате и подключенного 
непосредственно к выводам микроконтроллера (RB7, RB6, MCLR, GND, VDD). 

• Без разъёма на плате, непосредственно к соответствующим выводам 
отлаживаемого микроконтроллера. В этом варианте возможна внутрисхемная 
отладка QFP и DIE кристаллов установленных непосредственно в 
Отлаживаемую плату (см. раздел 2.5.2). 

 
1.6.2 Переходник MPLAB-ICD. 

 
Переходник MPLAB-ICD обеспечивает удобное соединение модуля MPLAB-ICD 
с Отлаживаемой платой, на которой отсутствует 6-контактный разъём. Модуль 
MPLAB-ICD соединятся с Переходником MPLAB-ICD через кабель длиной 9 
дюймов. Для внутрисхемной эмуляции, в панель, расположенную на 
переходнике должен быть установлен 40-pin микроконтроллер семейства 
PIC16F87x. Далее переходник устанавливается в 28-pin или 40-pin DIP-панель 
вместо микроконтроллера Отлаживаемой платы или Демонстрационной платы 
MPLAB-ICD, как описано в разделе 2.5.1. 
 
Переходник MPLAB-ICD, а вместе с ним и Модуль MPLAB-ICD питается от 
отлаживаемой платы напряжением от 3,0в до 5,5в. 

 
1.6.3 Демонстрационная плата MPLAB-ICD. 

 
Демонстрационная плата поставляется для демонстрации и ознакомления с 
PIC16F87x без использования реальной Отлаживаемой платы. К Модулю 
MPLAB-ICD она может быть подключена непосредственно или через переходник 
MPLAB-ICD. При использовании прямого подключения (без переходника), из 
Переходника можно вынуть кристалл PIC16F877 и установить его в панельку 
Демонстрационной платы для автономной работы. 
 
Демонстрационная плата имеет следующие аппаратные элементы: 
 

1. 40- и 28-pin панельки. Информация о использовании переходников для 
подключения к панельке с требуемым количеством выводов расположена в 
Разделе A.3.1 

2. Восемь DIP-переключателей для подключения/отключения любого из восьми 
светодиодов, подключенных к порту PORTC. 

3. Восемь красных светодиодов, подключенных к порту PORTC для индикации 8-
битных значений. 

4. Две кнопки без фиксации: одна - RESET, другая - для внешних воздействий на 
RB0. 

5. Потенциометр для аналогового ввода через RA0. 
6. Небольшое макетное поле. 
7. Соединительное поле для доступа выводам портов PIC16F87x для 
дополнительного макетирования. 

8. Джампер для выбора либо RC-осциллятора (частотой приблизительно 2МГц) 
либо внешнего генератора тактовой частоты. 

9. Панель для внешнего генератора тактовой частоты. 
10. Разъём 9в, 0,75А для подключения источника питания, подобного источнику 
питания программатора PICSTART Plus. 

11. Разводка и установочные места на плате для самостоятельного монтажа 
интерфейса RS232. 

12. Модульный 6-контактный разъём, который может быть использован для 
подключения Демонстрационной платы непосредственно к Модулю MPLAB-ICD. 
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Рисунок 1.3: Демонстрационная плата MPLAB-ICD. 

 
1.6.4 Программное обеспечение MPLAB IDE. 

Программное обеспечение MPLAB работает под управлением Windows 3.1, 
Windows 95/98, Windows NT, или Windows 2000. Оно обеспечивает полное 
отображение, модификацию, и управление Отлаживаемым устройством в 
процессе эмуляции. 

 

1.7 Интегрированная среда обработки (IDE) MPLAB. 
Рабочий стол MPLAB обеспечивает среду для разработки и отладки вашего 
приложения. MPLAB-ICD интегрирован в MPLAB IDE. Этот документ охватывает 
основные установки и работу MPLAB-ICD, но это не охватывает все функции 
MPLAB IDE. Читайте Руководство Пользователя MPLAB IDE, чтобы получить 
полное понимание особенностей и возможностей отладки MPLAB IDE. 
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1.8 Инструментальные средства разработки MPLAB. 
 
MPLAB IDE интегрирует несколько инструментальных средств, обеспечивая 
полную среду разработки. 

 
• MPLAB Project Manager (Менеджер Проекта). 
Используйте Project Manager, чтобы создать проект и работать с 
определенными файлами, связанными с проектом. При использовании проекта, 
исходный код (Source Code) компилируется и загружается в симулятор или 
эмулятор единственным щелчком мыши. 
 

• MPLAB Editor (Редактор). 
Используйте MPLAB Editor для создания и редактирования текстовых файлов, 
напрмер, Исходного кода программы, кода, и скрипт-файлов (сценариев) для 
линкера. 
 

• MPLAB-SIM Simulator (Симулятор). 
Программный симулятор моделирует выполнение команд и ввода - вывода PIC-
контроллеров (MCUs). 
 

• MPLAB-ICE Emulator (Эмулятор). 
Эмулятор MPLAB-ICE использует аппаратный блок для эмуляции PIC-
контроллеров в реальном времени в отлаживаемой системе или без неё. 
 

• MPASM  Универсальный Ассемблер / MPLINK Переместимый Линкер / 
MPLIB Библиотекарь 
MPASM ассемблер позволяет собирать (ассемблировать) Исходный код 
программы без выхода из MPLAB. MPLINK создает конечное приложение, 
связывая переместимые модули от MPASM и/или MPLAB-C17 (PIC17CXXX 
компилятора C). MPLIB управляет пользовательскими библиотеками для 
обеспечения максимального многократного использования кода. 
 

• Программаторы PRO MATE ® II и PICSTART ® Plus. 
Разработайте код с симулятором или эмулятором, ассемблируйте (соберите) 
или компилируйте его, и затем используйте один из этих программаторов для 
программирования кристаллов. 
 

• Инструментальные средства Третьих лиц. 
Большое количество других компаний делают инструментальные средства 
разработки для продукции Microchip, работающие с MPLAB. Обратитесь к 
документу Microchip Third Party Guide (DS00104). 
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Глава 2. 
Инсталляция MPLAB-ICD. 

 

2.1 Введение. 
 
Эта глава описывает, как установить аппаратную часть MPLAB-ICD и 
программное обеспечение и наладить связь между Демонстрационной платой 
MPLAB-ICD и компьютером. 

 

2.2 Основные моменты. 
 
Темы, освещенные в этой главе: 

• Компоненты набора MPLAB-ICD. 
• Системные требования компьютеру. 
• Установка Аппаратной части (Модуля MPLAB-ICD). 
• Установка Программного обеспечения. 

 

2.3 Компоненты набора MPLAB-ICD. 
 
Набор MPLAB-ICD содержит следующие изделия (Рисунок 2.1): 
 

1. Переходник MPLAB-ICD. 
2. Модуль MPLAB-ICD. 
3. Демонстрационная плата MPLAB-ICD. 
4. Кабель RS-232. 
5. 40-pin DIP и 28-pin SDIP соединительные панели. 
6. 9-дюймовый 6-контактный модульный кабель. 
7. CD с программным обеспечением MPLAB и документацией. 
8. Инструкции: 

MPLAB-ICD User�s Guide (этот документ). 
MPLAB IDE User�s Guide (не показан). 
MPASM with MPLINK and MPLIB User�s Guide (не показан). 

9. Карточка Гарантийной регистрации (не показана). 
 

 
Рисунок 2.1 Компоненты набора MPLAB-ICD. 
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2.4 Системные требования компьютеру. 
 

Вы должны установить MPLAB программное обеспечение компьютере, 
имеющем следующую минимальную конфигурацию: 
 

• PC - совместимая машина класса Pentium. 
• Операционная система Microsoft Windows 3.X, Windows 95/98, Windows NT, или 

Windows 2000 
• Минимально 16 Мегабайт RAM, Рекомендуется - 32 Мегабайта RAM. 
• 45 МБ доступного дискового пространства (HDD). 
• Один доступный последовательный порт (COM-порт). 

 

2.5 Установка Аппаратной части. 
 

2.5.1 Подключение Модуля, Переходника и 
Демонстрационной/Отлаживаемой платы. 

 
Подключите аппаратную часть MPLAB-ICD следуя шагами: 

 
• Вставьте 40-pin PIC16F87x микроконтроллер в 40-pin DIP панель, 
расположенную на переходнике MPLAB-ICD. 

Для отладки этих 
микроконтроллеров на 
Демонстрационной или 
отлаживаемой плате 

Устанавливайте в Переходник  
следующие микроконтроллеры: 

PIC16F870 PIC16F871 
PIC16F871 PIC16F871 
PIC16F873 PIC16F874 
PIC16F874 PIC16F874 
PIC16F876 PIC16F877 
PIC16F877 PIC16F877 

 
Примечание: Микроконтроллеры без 40-pin эквивалента не могут быть 
использованы с Переходником MPLAB-ICD. Для отладки подобных 
микроконтроллеров вы должны подключить Модуль MPLAB-ICD 
непосредственно к Демонстрационной/Отлаживаемой плате как описано в 
Разделе 2.5.2 

 
• Соедините между собой Модуль MPLAB-ICD и Переходник MPLAB-ICD 9-
дюймовым модульным кабелем. 

• Вставьте 40-pin соединительный разъём в 40-pin DIP разъём, расположенный на 
Демонстрационной плате MPLAB-ICD или Отлаживаемой плате. Если 
используется Демонстрационная плата MPLAB-ICD убедитесь, что вставлен 40-
pin удлинитель выводов. (см Раздел A.3.1) 

• Вставьте Переходник MPLAB-ICD в соединительную панельку 
Демонстрационной платы или Отлаживаемой платы (Рисунок 2.2). Если вы 
отлаживаете 28-pin микроконтроллер, включите  Переходник MPLAB-ICD в 28-
pin SDIP панель Демонстрационной или Отлаживаемой платы через 28-pin SDIP 
соединительную панель. 

• Подключите Модуль MPLAB-ICD к Последовательному порту компьютера 
используя кабель RS232. 

• Включите питание компьютера. 
• Подайте питание на Демонстрационную или Отлаживаемую плату, что также 
обеспечит и питание Модуля MPLAB-ICD. (Для Демонстрационной платы 
MPLAB-ICD вы должны использовать 9в. стабилизированный источник питания с 
разъёмом, имеющим положительный потенциал на центральном контакте. 
(Например, Источник питания, которым комплектуется программатор PICSTART 
Plus. 
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Рисунок 2.2 Подключение аппаратной части MPLAB-ICD. 
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2.5.2 Соединение Модуля и 
Демонстрационной/Отлаживаемой платы. 

 
Вы можете подключить Модуль MPLAB-ICD непосредственно к Отлаживаемой 
или Демонстрационной плате если ваша плата имеет модульный разъём (RJ-6), 
описанный в следующей таблице. 

 
Вывод 

разъёма J2 
Сигнал 

6 RB3 (не используется) 
5 RB6 
4 RB7 
3 Ground 
2 +VDD 
1 +VPP 

 
Эта конфигурация также обеспечивает полную функциональность MPLAB-ICD. 

 
Примечание переводчика #1: Даже если плата не имеет модульного разъёма, 
его всегда можно временно установить на любую плату в удобном месте и 
подключить его выводы короткими проводниками непосредственно к выводам 
отлаживаемого микроконтроллера. Однако, следует позаботиться об отсутствии 
соединений этих выводов со схемой. 
 
Модуль MPLAB-ICD монопольно использует следующие выводы 
микроконтроллеров семейства PIC16F87x: 
 
RB7; RB6; Ground (Vss); +VDD; MCLR (VPP). 
 
Вывод RB3, описываемый в фирменном User Guide как используемый, можно не 
подключать, т.к. Модуль не использует протокол Low Voltage Programming. 
Пользователь может использовать этот вывод по своему усмотрению как 
обычный I/O вывод. 
 
Примечание переводчика #2: Даже временный модульный разъём можно не 
устанавливать. Как правило, для получения разъёмного соединения бывает 
достаточно того разъёма, который установлен на плате Модуля MPLAB-ICD. В 
этом случае к вышеперечисленным контактам подключается короткий отрезок 
плоского 6-ти проводного кабеля, который с другой стороны (подключаемой к 
Модулю MPLAB-ICD) имеет модульный разъём. Отрезок кабеля желательно 
зафиксировать любым методом в любой точке платы для исключения 
обламывания проводников, припаянных непосредственно к выводам 
микроконтроллера в процессе перемещений отлаживаемой платы. 

 
1. Вставьте PIC16F87x в 28-pin или 40-pin DIP панель Демонстрационной платы 

MPLAB-ICD или Отлаживаемого устройства. 
2. Подключите 9-дюймовый модульный кабель между Модулем MPLAB-ICD и 
Демонстрационной платой MPLAB-ICD или платой Отлаживаемого устройства. 

3. Подключите Модуль MPLAB-ICD к Последовательному порту компьютера 
используя кабель RS232. 

4. Включите питание компьютера. 
5. Подайте питание на Демонстрационную или Отлаживаемую плату, что также 
обеспечит и питание Модуля MPLAB-ICD. (Для Демонстрационной платы 
MPLAB-ICD вы должны использовать 9в. стабилизированный источник питания с 
разъёмом, имеющим положительный потенциал на центральном контакте. 
(Например, Источник питания, которым комплектуется программатор PICSTART 
Plus). 
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Рисунок 2.3 Подключение Модуля MPLAB-ICD к плате (без Переходника). 
 
 

2.6 Установка Программного обеспечения. 
 

MPLAB-ICD - дополнительный инструмент для MPLAB IDE. Для установки 
MPLAB IDE следуйте инструкции: 
 

1. Запустите Microsoft Windows и затем вставьте MPLAB IDE CD-ROM в ваш CD-
дисковод. 

2. Запустите программу установки MPLAB-IDE. 
3. Следуйте инструкцим для установки MPLAB IDE с поддержкой MPLAB-ICD. 
Убедитесь, что в диалоге �Выбор компонентов� (Component selection) помимо 
прочего отмечен и пункт MPLAB-ICD. 
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Глава 3. 
Обучающая программа (tutorial) Tut877. 

 

3.1 Введение. 
 
MPLAB-ICD - помимо того, что является Внутрисхемным Отладчиком - ещё и 
Внутрисхемный программатор семейства PIC16F87x. Эта обучающая программа 
поможет Вам начать использовать модуль MPLAB-ICD и программное 
обеспечение, для программирования кристалла в Отлаживаемом устройстве и 
отладки исходного кода. 
 
Эта обучающая программа использует типовой проект - Tut877. Программа 
tut877.asm - простой пример применения PIC16F877 в качестве аналого-
цифрового преобразователя с использованием Демонстрационной платы 
MPLAB-ICD. Эта программа конфигурирует A/D модуль, для преобразования на 
канале A/D 0 (подключенном к измерительному потенциометру 
Демонстрационной платы) и отображает результат на 8-ми светодиодах, 
подключенных к  PORTC. 

 

3.2 Основные моменты. 
 

Темы, освещенные в этой главе: 
 

• Создание Шестнадцатеричного (.HEX) Файла для Отладки. 
• Настройка MPLAB-ICD и MPLAB IDE. 
• Настройка ICD Программирования и Опции Отладки. 
• Программирование PIC16F877. 
• Установки Демонстрационной платы. 
• Запуск Tut877. 
• Отладка Tut877. 
• Функционирование Tut877. 

 

3.3 Прежде, чем Вы Начинаете. 
 

Этот проект требует, чтобы Отладчик MPLAB-ICD был подключен к вашему PC 
как описано в Секции 2.5. MPLAB IDE также должна быть установлена и 
запущена. 
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3.4 Создание Шестнадцатеричного (HEX) файла для 
Отладки. 

Вам необходимо создать новый проект чтобы вставить исходный файл 
tut877.asm и сформировать шестнадцатеричный файл tut877.hex. См. 
следующие разделы, поясняющие, как создать новый проект tut877.pjt. 

 
3.4.1 Новый Каталог для Проекта. 

 
В Диспетчере файлов (Windows 3.1) или Проводнике Windows, создайте 
подкаталог для нового проекта, \MPLAB\tut877. Скопируйте tut877.asm файл из 
каталога  \MPLAB в этот каталог. 

 
3.4.2 Новый Проект. 

 
Выберите Project > New Project, укажите каталог для нового проекта, и затем 
введите tut877.pjt в поле File Name. Нажмите OK. 

 

 
Рисунок 3.1: Новый проект - tut877.pjt 
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3.4.3 Диалог Project (Проект). 
 

Должен открыться диалог Редактирования проекта (Edit Project). 
 

 
Рис. 3.2: Диалог Edit Project перед установками Development Mode. 

 
Обратите внимание на development mode. Он показывает, что мы работаем с 
симулятором MPLAB-SIM и процессором PIC12C508. На вашем дисплее будет 
тот development mode и процессор, с которым вы работали с последний раз в 
MPLAB IDE. Сейчас необходимо изменить этот параметр. Нажмите Change. 
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Рис. 3.3: Установки Development Mode. 
 
Выберите MPLAB-ICD Debugger на вкладке Tools. Убедитесь, что вы выбрали 
PIC16F877 процессор. Нажмите OK. MPLAB IDE теперь установит связь с 
MPLAB-ICD. Во время этого процесса на мгновенье появится Диалог MPLAB-
ICD. Если Вы получили сообщение об ошибке, проверьте подключение 
источника питания, разъемы, и соединительные кабели. В Главе 7 вы найдёте 
более детальную информацию по устранению проблем. 
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Рис. 3.4: Диалог Edit Project. 
 
Обратите внимание, что правильный development mode и процессор показаны в 
диалоге Edit Project. 
 
Нажмите на строку tut877 [.hex] в области Project Files диалога Edit Project, и 
затем нажмите кнопку Node Properties. 
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3.4.4 Установка Node Properties. 
 
Диалог Node Properties показывает переключатели командной строки для 
инструмента, в нашем случае это ассемблер MPASM. При первом открытии 
этого диалога, отмечаемые поля представляют значения по умолчанию для 
данного инструмента. Для рассматриваемой обучающей программы, нет 
необходимости изменять эти параметры настройки (оставить значения по 
умолчанию). 
 
Нажмите OK, чтобы возвратиться к диалогу Edit Project. 

 

 
Рисунок 3.5: Диалог Node Properties. 
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3.4.5 Add Node. 
 

Нажмите Add Node в диалоге Edit Project, чтобы открыть Диалог Add Node. 
 

Выберите tut877.asm для этой обучающей программы, и затем нажмите OK. 
 

 
Рис. 3.6: Add Node. 
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3.4.6 Полная Настройка Проекта. 
 

В этом простом примере, отметок нет в полях Path. Когда ваши приложения 
станут более комплексными, в соответствующих полях вы можете ввести пути к 
каталогам, содержащим включаемые (include) файлы. 

 
Ассемблер MPASM всегда делает .hex файл с тем же самым названием, что и 
Исходный .asm-файл. Менеджер проекта (Project Manager) создаст файл 
tut877.hex, при формировании проекта (built). 

 

 
Рис. 3.7: Диалог Edit Project с Узлами (Node). 

 
Нажмите OK, чтобы закрыть Диалог Edit Project. 
 
Теперь выберите Project > Save Project в меню MPLAB IDE, чтобы сохранить 
ваш проект. 
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3.4.7 Make Project  (Собрать проект). 
Выберите Project > Make Project из меню, для компиляции приложения, 
используя MPASM. Окно Build Results покажет командную строку, посланную 
ассемблеру. Это должно выглядеть следующим образом: 

 

 
Рис. 3.8: Окно Build Results (Результаты сборки проекта). 

 
Примечание: Сообщение [302] просто дает вам знать, что в указанном номере 
строки (то есть, 31, 32 и 34) вы определяете ячейку памяти (file register), которая 
находится не в Банке 0. Это не является ошибкой и ваш код компилируется 
правильно. 

 
Нажмите "X" в верхнем правом углу окна Build Results, чтобы закрыть его. Или 
нажмите иконку Restore рядом с X, чтобы изменить размеры окна. Последующие 
сборки проекта будут выводить это уменьшенное вами окно Build Results. 
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3.5 Настройка MPLAB-ICD и MPLAB. 
 
В этой точке диалог MPLAB-ICD должен быть на вашем рабочем столе. 
Настройте его как описано в данном разделе чтобы использовать MPLAB IDE с 
платой Модуля MPLAB-ICD. 

 

 
Рис. 3.9: Диалог MPLAB-ICD. 

 
Таблица 3.1: Диалог MPLAB-ICD. 
Пункт Опция 
Status Строка Status отображает выполненную функцию MPLAB-

ICD и текущее состояние. Когда Вы программируете 
устройство, в этом месте вы можете наблюдать процесс 
выполнения. Когда операция полна, поле Status отображает 
сообщение "Waiting for user command." (ожидание команды 
пользователя). 

Меню COM 
Port и Baud 
Rate. 

Удостоверьтесь, что эти значения соответствуют 
параметрам настроек вашей Операционной Системы. 

Меню Upload 
Options 

Для начала выберите значение Minimum. Позже в 
обучающей программе мы изменим его во время отладки. 

Меню 
Operating 
Frequency 
Range 

Выберите диапазон рабочих частот 2MHz - 10MHz. 

 
Нажмите Options, чтобы продолжить настройку. 
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3.6 Настройка Опций Программирования и Отладки ICD 
 

Чтобы программировать отлаживаемый PIC16F877, сначала следует настроить 
диалог ICD Options для программирования. Ранее, при входе в development 
mode появился Диалог MPLAB-ICD. Нажмите Options в Диалоге MPLAB-ICD, 
чтобы открыть диалог ICD Options (Опции ICD). 

 

 
Рис. 3.10: Диалог MPLAB-ICD Options. 
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3.6.1 Биты Конфигурации (Configuration Bits) и Выбор типа 
Кристалла (Device) 

 
Этот раздел диалога ICD Options позволяет вам устанавливать различные биты 
конфигурации для микропроцессоров PIC16F87X. Нажмите стрелку и выберите 
из списка. 

 
Таблица 3.2: Configuration Bits и Device Selection. 
Пункт Опция 
Device Должно быть указано, что выбран PIC16F877 как в Диалоге 

Development Mode. Если это не так, используйте пункты меню 
Project, чтобы сохранить и закрыть ваш проект. Выберите 
Options > Development Mode, укажите требуемый 
микроконтроллер (PIC16F877), и нажмите OK. Затем, повторно 
откройте проект Tut877. 

Oscillator В этой обучающей программе используется RC-осциллятор. 
Проверьте установки Демонстрационной платы и 
удостоверьтесь, что джампер JP1 выбора осциллятора 
корректно установлен в позицию RC OSC (см. пункт 8 на 
Рисунке 1.3). Частота RC осциллятора - приблизительно 2MHz. 

Watchdog 
Timer 

Для этой обучающей программы Охранный таймер (WDT) 
должен быть выключен (off/disabled). 

Power Up 
Timer 

Для этой обучающей программы Таймер включения (PWRT) 
должен быть включен (on/enabled). 

Brown Out 
Detect 

Для этой обучающей программы Детектор дрожания 
напряжения питания (BOD) должен быть выключен 
(off/disabled). 

Low Voltage 
Program 

Низковольтное ICSP программирование должно быть 
заблокировано при использовании MPLAB-ICD. Это означает, 
что вы можете использовать RB3 как цифровой вход-выход. 
Используется режим программирования Высоким напряжением 
(+13в), напряжение VPP подаётся через вход MCLR. 

Code Protect 
Data EE 

Выключите защиту данных EEPROM для этой обучающей 
программы. 

Flash Memory 
Write 

Запись через EECON выключена для этой обучающей 
программы. 

Code Protect Защита кода программы выключена для этой обучающей 
программы. 

 
3.6.2 ID и Checksum. 

 
Здесь отображаются Контрольная сумма данных и код ID. Для этой обучающей 
программы, Контрольная сумма может быть использована как ID отметкой в 
поле "Use checksum as ID". 

 
3.6.3 Voltages (Напряжения). 

 
Эти поля позволяют вам проверять VDD и VPP напряжения в отлаживаемой 
плате, щелкая кнопку Update. 

 
MPLAB-ICD генерирует напряжение VPP 13v из VDD используя собственный 
преобразователь напряжения. 

 
Внимание! 

Показания напряжения VPP и VDD могут быть неверными ввиду того, что на плате 
модуля MPLAB-ICD изменены делители напряжения для обеспечения 
работоспособности модуля при пониженных напряжениях питания вплоть до +3в. 
Подробности см. в файле etn21x.pdf, где x- номер текущей версии файла. Файл доступен 
на сайте компании Microchip: http://www.microchip.com или по ссылке: 
http://www.microchip.com/10/Tools/picmicro/icds/MPLABICD/index.htm 
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3.6.4 Параметры Программирования (Program Options). 
 

Диапазон адресов программы (Start Address и End Address) - Длина памяти 
программ или памяти данных, которая будет считываться, программироваться 
или проверяться Модулем. Заданный по умолчанию диапазон адресов памяти 
программ установлен на максимальную длину, доступную для выбранного вами 
микроконтроллера. Рассматриваемая обучающая программа использует 
значения по умолчанию.  

 
Убедитесь, что все поля под Program Options отмечены. Это означает, что вся 
память программ, ячейки ID, и биты конфигурации будут запрограммированы. 
Также, вся память будет стерта перед программированием, и после 
программирования запущен Режим Отладки. 

 
3.6.5 Функциональные клавиши. 

 
Во время отладки вы можете нажимать эти кнопки для выполнения назначенных 
им функций PIC16F87x в Переходнике MPLAB-ICD или 
Отлаживаемой/Демонстрационной плате. 

 

3.7 Программирование PIC16F877. 
 

Нажмите кнопку Program, для программирования tut877.hex и отладки кода в 
PIC16F87X на макете. Программирование может занять пару минут. В течение 
программирования, поле Status показывает процесс выполнения. По 
завершении программирования, поле Status отображает сообщение "Waiting for 
user command." (Ожидание команды пользователя). 

 
Примечание: Адреса 1F00h-1FFFh для PIC16F877, заняты специальным 
отладочным кодом, который необходим для использования Внутрисхемной 
отладки MPLAB-ICD. 

 
Вы можете минимизировать или перемещать MPLAB-ICD диалог, но не 
закрывайте его. Закрытие Диалога MPLAB-ICD отключит ICD. Чтобы вновь 
включить ICD, Вы будете должны выбрать Options > Development Mode. 
Выберите Editor Only, и нажмите Apply. Затем выберите MPLAB-ICD, и нажмите 
OK, чтобы вновь включить ICD. 
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3.8 Конфигурация Демонстрационной платы. 
 

Перед тем, как начать отладку убедитесь, что Демонстрационная плата 
сконфигурирована: 

 
• Перемычкой JP1 выбрана опция RC OSC. 
• Все движки DIP-переключателя (SW3) находятся в положении ON, подключая 
все светодиоды к соответствующим выводам порта PORTC. 

 

 
Рисунок 3.11: Конфигурация Демонстрационной платы. 

 

3.9 Запуск Tut877. 
 

MPLAB-ICD работает в режиме в реального времени или пошаговом режиме. 
 

• Работа в режиме реального времени происходит когда Отлаживаемый 
PIC16F87x переводится в режим Run MPLAB IDE. 

• Выполнение по шагам можно использовать после того, как процессор 
приостановлен командой Halt. 

 
Начните с режима выполнения в реальном времени: 

 
• Откройте tut877.asm файл для просмотра (Open > File) 
• Нажмите кнопку панели Run или выберите команду: Debug > Run > Run. 

 
Строка состояния внизу рабочего стола MPLAB IDE должна стать желтой. Чтобы 
изменять цвет, указывающий выполнение программы, выберите Options > 
Environment Setup и нажмите Colors. 

 
На Демонстрационной плате, установите положение потенциометра, 
подключенного к выводу RA0, в среднее положение. Наблюдайте за 
светодиодами. Если бы программа работала корректно, вы бы увидели 
двоичное представление значения напряжения на движке потенциометра. 
Однако, коварная ошибка была СПЕЦИАЛЬНО помещена в программу Tut877! 
Именно это даст нам возможность отладить код. 

 
Нажмите кнопку панели Halt, или выберите команду Debug > Run > Halt, чтобы 
остановить выполнение программы. Сбросьте программу, выбрав  Debug > Run 
> Reset. 
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3.10 Отладка Tut877. 
 

Любой пункт из перечисленного может не допустить корректной работы 
программы Tut877: 

 
• Значение A/D преобразователя должным образом не записывается в PORTC 

(светодиоды). 
• A/D преобразователь не включен или не запущено преобразование. 
• Ошибки в исходном коде заставляет программу функционировать 
ненадлежащим образом. 

 
Чтобы исследовать первую возможность, установите точку останова (Break 
point) на строку файла, которая записывает значение результата A/D в PORTC. 
Поместите курсор в следующую строку программы из tut877.asm: 

 
movf ADRESH,W  ;Write A/D result to PORTC 

 
Нажмите правую кнопку мыши, чтобы появилось меню. Выберите Break Point(s) 
из меню как показано на Рисунке 3.12. Эта строка теперь будет маркирована как 
точка останова. Чтобы изменять цвета, которые отмечают точки останова, 
выберите Options > Environment Setup и нажмите Colors. 

 

 
Рис. 3.12: Установка Точки останова (Breakpoint). 
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Нажмите кнопку панели Run, или выберите команду Debug > Run > Run, чтобы 
ещё раз запустить программу в режиме реального времени. 

 
Точка останова остановит выполнение программы, когда программа выполнит 
строку, отмеченную как точка останова (break point). Однако, наша простая 
программа не остановится. Поэтому, остановите её самостоятельно, щелкая 
кнопку панели Halt или выберите команду Debug > Run > Halt. 

 
Взгляните на окно исходного кода (tut877.asm) и заметьте, где программа 
остановилась. Наша простая программа, приостановлена на одной из двух строк 
в подпрограмме Wait как показано на Рис. 3.13. Основываясь на месте останова 
и знании, что программа никогда не достигает точки останова, мы заключаем, 
что проблема находится в A/D преобразовании - A/D флаг завершения 
преобразования не установился. 

 

 
Рис. 3.13: Программа остановлена. 
 
Инициализация A/D преобразования и настройка происходит в начале 
программы. Для проверки этого кода сначала сбросьте программу,  выбрав 
Debug > Run > Reset. Первая команда после Start должна быть подсвечена. 
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Создайте окно просмотра (Watch window), так что вы могли наблюдать 
изменение значений регистра A/D, во время выполнения программы. Выберите 
Window > Watch Windows > New Watch Window. Откроется диалог Add Watch 
Symbol (добавление наблюдаемого символа) с новым окном просмотра Watch_1 
позади него. Добавьте (Add) символы ADCON0 и ADCON1 как показано на Рис. 
3.14. 

 

 
Рис. 3.14: Добавление символов для просмотра (Add Watch Symbols). 

 
В завершение нажмите Close. Отобранные символы должны теперь быть 
видимы в окне просмотра как показано в Рисунке 3.15. 

 

 
Рис. 3.15: Окно просмотра. 

 
В диалоге MPLAB-ICD, установите параметры загрузки в Minimum & Watch 
Windows. Теперь программа станет работать медленнее, но эта установка 
позволяет нам наблюдать содержимое окон Watch в процессе отладки. 
Закройте или минимизируйте диалог MPLAB-ICD Options. 

 
В Исходном коде tut877.asm установите точку останова на вторую команду 
после Start. Установите курсор в следующую строку программы tut877.asm: 

 
clrf PORTC   ;Clear PORTC 

 
Нажмите правую кнопку мыши, чтобы появилось меню. Выберите Break Point(s) 
из меню. Эта строка теперь будет маркирована отмечена как точка останова. 
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В завершение, нажмите кнопку панели Run, или выберите команду Debug > Run 
> Run чтобы запустить  программу в режиме в реального времени. 

 
На сей раз программа остановится после того, как выполнит строку программы с 
точкой останова, и инструкция после точки останова будет подсвечена как 
показано в Рис. 3.16. 

 

 
Рис. 3.16: Программа приостановлена после точки останова. 

 
Теперь, выполняя пошаговую отладку нажимая на кнопку панели Step или 
выполняя команду Debug >Run > Step. Сделайте 2 шага программы и затем, 
проверьте значения регистров ADCON0 и ADCON1 в окне просмотра. Вы 
должны обратить внимание, что ADCON0 имеет значение 40 (hex) как показано в 
Рисунке 3.17. 
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Рис. 3.17: Обновлённое окно просмотра. 

 
Это соответствует двоичному значению, обозначенному в программе, но 
правильное ли это значение? При исследовании PIC16F87X Data Sheet 
(DS30292) в описании на A/D, вы увидите, что последний бит должен быть 1, а 
не 0 для включения модуля A/D. 

 
Для исправления этой ошибки измените: 

 
movlw B'01000000'   ;Fosc/8, A/D enabled 
 
на 
 
movlw B'01000001'   ;Fosc/8, A/D enabled 
 
Выберите File > Save, чтобы сохранить ваши изменения, и выберите Project > 
Make Project для новой сборки проекта. 
 
Будет выдано сообщение, о том, что программа была собрана, и вы должны 
перепрограммировать ICD для того, чтобы ваши изменения вступили в силу. 
Нажмите кнопку Program в диалоге MPLAB-ICD, чтобы перепрограммировать 
Отлаживаемый кристалл. 
 
Когда поле Status диалога MPLAB-ICD появится сообщение, что система это 
ожидает вашу следующую команду, можете запускать программу вновь. 
 
Нажмите кнопку панели Run, или выберите Debug > Run > Run, чтобы 
запустить программу в режиме в реального времени. Некоторые из светодиодов 
должны теперь светиться. Поверните движок измерительного потенциометра, 
подключенного к RA0, чтобы изменить значение, отображаемое на светодиодах. 
 
Исходный текст в этой обучающей программе содержал только одну ошибку. 
Однако, реальный код может иметь больше. Используя функции отладки 
MPLAB-ICD и MPLAB IDE, вы можете успешно находить и устранять ошибки в 
вашем коде. 
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3.11 Tut877 Главная (Main) Подпрограмма. 
 
Главная (Main) подпрограмма tut877.asm (Рисунок 3.18) начинается с 
конфигурации PORTC, A/D модуля и таймера Timer0. Затем, ждёт переполнения 
Timer0, чтобы запустить A/D преобразование значения на измерительном 
потенциометре. После окончания преобразования, значение отображается на 
светодиодах, и программа зацикливается, на  ожидании следующего 
переполнения Timer0, чтобы запустить следующее A/D преобразование. 

 
Для более подробной информации о работе с модулем A/D, пожалуйста 
обратитесь к PICmicroMidrange Microcontroller Family Reference Manual 
(DS33023) для получения функциональных описаний и списка Готовых 
прикладных программ (Application Notes). 

 

 
Рис. 3.18: Алгоритм программы. 
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3.12 Tut877, исправленный Исходный код. 
 

Это исправленная версия tut877.asm. 
 
;********************************************************** 
;* TUT877.ASM 
;********************************************************** 
;* Microchip Technology Incorporated 
;* 16 December 1998 
;* Assembled with MPASM V2.20 
;********************************************************** 
;* This program configures the A/D Module to convert on 
;* A/D channel 0 (the potentiometer) and display the 
;* results on the LEDS on PORTC. Make sure that the DIP 
;* switch SW3 has all switches in the ON position. 
;********************************************************** 
 
 list p=16f877 
 
 ; Include file, change directory if needed 
 include "p16f877.inc" 
 
 ; Start at the reset vector 
 org 0x000 
 nop 
Start 
 banksel PORTC 
 clrf PORTC    ;Clear PORTC 
 movlw B'01000001'   ;Fosc/8, A/D enabled 
 movwf ADCON0 
 
 banksel OPTION_REG 
 movlw B'10000111'   ;TMR0 prescaler, 1:256 
 movwf OPTION_REG 
 clrf TRISC    ;PORTC all outputs 
 movlw B'00001110'   ;Left justify,1 analog channel 
 movwf ADCON1   ;VDD and VSS references 
 
 banksel PORTC 
Main 
 btfss INTCON,T0IF   ;Wait for Timer0 to timeout 
 goto Main 
 bcf INTCON,T0IF 
 
 bsf ADCON0,GO   ;Start A/D conversion 
Wait 
 btfss PIR1,ADIF   ;Wait for conversion to complete 
 goto Wait 
 movf ADRESH,W   ;Write A/D result to PORTC 
 movwf PORTC    ;LEDs 
 
 clrf PORTC 
WaitPush 
 btfss PORTB,0 
 goto WaitPush 
 
 movwf PORTC 
 goto Main    ;Do it again 
 
 end 
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Глава 4. 
Стартуем с MPLAB-ICD. 

 

4.1 Введение. 
 

Эта глава описывает, как заставить аппаратную и программную часть MPLAB-
ICD работать. 

 

4.2 Основные моменты. 
 

Темы, освещённые в этой главе: 
 

• Связь с MPLAB-ICD. 
• Работа с MPLAB-ICD. 
• Получение максимума от MPLAB IDE - Использование Проектов. 

 

4.3 Связь с MPLAB-ICD. 
 

Следуйте шагам, описанным ниже, чтобы установить MPLAB IDE для 
использования с аппаратной частью (Модулем) MPLAB-ICD. 

 
1. Убедитесь, что Модуль MPLAB-ICD подключен к PC через кабель RS-232 как 
описано в Разделе 2.5. 

2. Убедитесь, что питание подано на Отлаживаемую плату, с которой MPLAB-ICD 
будет получать питание. 

3. Запустите программу MPLAB IDE. 
4. Выберите Options > Development Mode и щёлкните на Tools, чтобы открыть 
диалог Development Mode. 

5. Выберите MPLAB-ICD development mode. Выберите микропроцессор PIC16F87X, 
который вы собираетесь отлаживать. 
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Рис. 4.1: Окно Диалога Development Mode. 

 
6. Щёлкните на OK. 

 
Диалог Development Mode закроется, и откроется диалог MPLAB-ICD. 

 
Примечание: Если вы закрыли диалог MPLAB-ICD, выберите Options > 
Development Mode и нажмите Tools, чтобы вновь открыть диалог Development 
Mode. Выберите MPLAB-ICD Debugger, и нажмите OK. Диалог MPLAB-ICD 
повторно откроется. 

 
Если предшествующий сеанс работы с MPLAB IDE использовал режим ICD, 
MPLAB IDE либо найдёт Модуль MPLAB-ICD и запустит, либо выдаст 
сообщение, что это она не может обнаружить Модуль MPLAB-ICD. Если MPLAB 
IDE не может найти MPLAB-ICD, выберите опцию Editor Only из диалога и 
нажмите Apply. Затем, повторите шаги 4 - 6. 
 
Для получения подробной информации о диалогах MPLAB-ICD см. Главу 5. 
 
Если MPLAB IDE не может обнаружить MPLAB-ICD - см. Главу 7. 
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4.4 Работа с MPLAB-ICD. 
 

MPLAB-ICD - не только Внутрисхемный Отладчик для семейства PIC16F87X но и 
Внутрисхемный Программатор. Он программирует шестнадцатеричные (hex) 
файлы в PIC16F87X и обеспечивает основные элементы отладки типа 
выполнения кода в реальном времени, пошаговой отладки и точек останова 
(breakpoints). Элемент отладки встроен внутрь микропроцессоров семейства 
PIC16F87X и активизируется программированием Отладочного Кода в 
отлаживаемый процессор. Это ограничивает функции по сравнению с 
настоящим внутрисхемным эмулятором, но обеспечивает недорогую 
возможность отладки и программирования для PIC16F87X. 

 
Для обеспечения Внутрисхемной отладки Отладочный код, располагающийся в 
микроконтроллере Модуля MPLAB-ICD программируется в Отлаживаемый 
PIC16F87x. Этот код располагается в конце памяти программ. Например, он 
расположен по адресам 0x1F00...0x1FFF у микроконтроллера PIC16F877 (см. 
Раздел 1.5). 

 

4.5 Получение Максимума от MPLAB IDE - 
Использование Проектов. 
 

MPLAB IDE - ведущее программное обеспечение для MPLAB-ICD и симулятора 
MPLAB-SIM. Оно функционирует как сложное средство отладки, обеспечивая 
доступ к RAM, ROM, EEPROM и ряду других отлаживаемых функций. 

 
Примечание: Если вы не помещаете ваши исходные файлы в проект, MPLAB 
IDE не может отлаживать их корректно. 

 
4.5.1 Элемент Проект (Project) MPLAB IDE. 

 
Разработка и отладка кода в MPLAB IDE базируется на проектах. Хотя эмуляция 
может быть выполнена и без использования проекта, проекты имеют 
следующие преимущества: 

 
• Единственный или множество исходных файлов могут легко собираться и 
поддерживаться. 

• Доступна Символическая отладка. 
• Вся среда отладки может быть сохранена для более позднего использования. 

 
Информация, которая сохраняется вместе с проектом: 

 
• Development mode и Тип микропроцессора. 
• Исходные файлы, связанные с проектом. 
• Имя конечного PICmicro исполняемого файла. 
• Открытые окна, их размеры и позиции. 
• Именованные точки останова. 
• Установки конфигурационных битов. 



 37 

4.5.2 Создание Проекта. 
 

Выберите Project > New Project для открытия диалога Edit Project и создайте 
проект. Проект будет содержать информацию о Исходном файле, объектах, и 
других файлах, а также ряде важных установок проекта. 

 
4.5.3 Сохранение Проекта. 

 
Для сохранения вашего текущего проекта для более позднего использования 
или использования как резервной копии или как значений по умолчанию, перед 
продолжением отладки, нажмите OK в диалоге Edit Project. Затем, выберите 
Project > Save Project для сохранения вашего проекта. 

 
Development Mode 

 
Выбранный режим разработки (Development Mode) сохраняется с информацией 
о проекте. Для изменения development mode, следуйте шагам: 

 
• Откройте проект. Будет выбран предыдущий development mode. 
• Измените development mode, выбрав Options > Development Mode, для 
получения доступа к диалогу Development Mode. Выберите режим разработки 
(development mode), и нажмите OK. 

 
Выберите Project > Save Project для сохранения проекта. 

 
Более подробную информацию о создании и использовании проектов, ищите в 
MPLAB IDE User's Guide (DS51025). 
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Глава 5. 
Базовые функции MPLAB-ICD. 

 

5.1 Введение. 
 
Эта глава описывает базовые операции MPLAB-ICD и функции отладки MPLAB 
IDE для Внутрисхемного Отладчика. Для получения более детальной 
информации об основных элементах отладки обратитесь к MPLAB IDE User�s 
Guide. 

 

5.2 Основные моменты. 
 

Темы, затронутые в этом разделе: 
 

• Диалоги MPLAB-ICD. 
• Выполнение программы. 
• Точки останова (break points). 
• Как пользоваться MPLAB-ICD. 
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5.3 Диалоги MPLAB-ICD. 
 

Как только вы настроили MPLAB-IDE для работы с MPLAB-ICD, вы можете 
сконфигурировать MPLAB-ICD для Программирования и Отладки. 

 

5.3.1 Диалоги MPLAB-ICD. 
 

При запуске ICD всегда открывается диалог MPLAB-ICD. Вы можете 
минимизировать или перемещать MPLAB-ICD диалог, но не закрывайте его. 
Закрытие Диалога MPLAB-ICD отключит ICD. Чтобы вновь включить ICD, Вы 
будете должны выбрать Options > Development Mode , Выбрать MPLAB-ICD, и 
нажать OK для повторного запуска Отладчика. 

 

 
Рисунок 5.1 Диалог MPLAB-ICD. 

 
Диалог MPLAB-ICD имеет следующие установки: 

 
Таблица 5.1 Диалог MPLAB-ICD. 
Пункт Опция 
Status Поле �Status� индицирует процесс выполнения функции MPLAB-ICD 

и его статус. 
COM Port Выбирает COM-порт (COM1, COM2, COM3 или COM4) для связи с 

MPLAB-ICD. 
Baud Rate Выбирает скорость обмена через COM-порт для MPLAB-ICD.  
Upload 
Options 

Опции определяющие количество считываемых из Отлаживаемого 
микроконтроллера данных: 
 

• Minimum (FSR, W, Status, PCLATH) (Максимальная скорость). 
• SFRs only (Большая скорость). 
• Minimum and Watch windows (Средняя скорость). 
• All Registers (Медленно). 
 

Выбранные данные будут считываться из Отлаживаемого 
микроконтроллера только при в режиме пошаговой отладки (Single 
Step) после каждого шага или сразу, после остановки на точке 
останова (break point), или после выполнения команды Останов 
(Halt). 
От выбранного количества считываемых данных зависит скорость 
их загрузки. В самом медленном варианте это может занять до 2 
секунд. 

 
Примечание: Для сохранения этих настроек кликните на �крестике� в правом 
верхнем углу Диалога MPLAB-ICD перед выходом из Отладчика или закройте 
ваш Проект. 

 
Таблица 5.1 Диалог MPLAB-ICD (Продолжение). 
Пункт Опция 
Operating 
Frequency 
Range 

Выбор диапазона тактовых частот, соответствующего 
тактовой частоте используемой в Отлаживаемом 
устройстве. 

Reconnect После смены COM-порта или скорости обмена (baud rate) 
нажмите Reconnect для восстановления связи с 
использованием новых установок. 

 
Далее, в Диалоге MPLAB-ICD нажмите Options для открытия Диалога ICD 
Options. 
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5.3.2 Диалог ICD Options. 
 

Диалог ICD Options выводится нажатием Options в Диалоге MPLAB-ICD. Диалог 
ICD Options может быть минимизирован или закрыт без выключения ICD. 

 
Диалог ICD Options (Рисунок 5.2) имеет все опции программирования и 
настройки функций MPLAB-ICD. Эти функции включают в себя основные 
функции программирования, такие как проверка на стирание (blank check), 
программирования (program), чтения (read), проверки записанного (verify), 
стирания (erase), и режима отладки (debug mode). 

 

 
Рисунок 5.2 Диалог Options MPLAB-ICD. 

 
Диалог ICD Options имеет следующие настройки. 
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5.3.3 Конфигурационные биты (Configuration Bits) и выбор 
типа контроллера. 

 
Этот раздел Диалога позволяет установить значения различных 
конфигурационных битов для процессоров PIC16F87x. Для выбора нажмите 
стрелку соответствующего пункта и из появившегося списка выберите 
необходимое. 

 
Таблица 5.2 Конфигурационные Биты и опции выбора типа 
микроконтроллера. 
Пункт Опция 
Device Этот пункт показывает тип процессора, выбранного в Диалоге 

Development Mode. Если вы измените тип процессора здесь, 
любые открытые проекты MPLAB-IDE будут автоматически 
закрыты (исключение для режима Editor Only), память 
программ, конфигурационные биты, и ячейки ID будут 
очищены. 

Oscillator RC, LP, XT или HS. 
Watchdog 
Timer 

Выбор из: On/Enable или Off/Disable. Обычно выключен 
(Off/Disable) при отладке. 

Power Up 
Timer 

Выбор из: On/Enable или Off/Disable. Обычно выключен 
(Off/Disable) при отладке. 

Brown Out 
Detect 

Выбор из: On/Enable или Off/Disable. Должен быть выключен 
(Off/Disable) при отладке. 

Low Voltage 
Program 

Выбор из: 
• функции Low Voltage Programming. 
• возможности использования RB3 как обычного I/O вывода, 
при этом, используется Высокое напряжение (+13в.) 
подаваемое на MCLR для программирования. Режим Low 
Voltage ICSP programming должен быть выключен 
(Disable) для отладки. 

Code Protect 
Data EE 

Выбор из: On/Enable или Off/Disable. Должен быть выключен 
(Off/Disable) при отладке. 

Flash Memory 
Write 

Даёт возможность записи незащищенной памяти программ 
через EECON. Должно быть выключено (Disabled) для 
отладки. 

Code Protect Выбор необходимого диапазона защищаемых адресов памяти 
программ. Должен быть выключен (Disabled) для отладки. 

 
5.3.4 Идентификационные ячейки (ID) и Контрольная сумма 
(Checksum). 

 
Таблица 5.2 Опции выбора ID и контрольной суммы 
Пункт Опция 
Checksum Показывает контрольную сумму данных. 
ID code Показывает Идентификационный код (ID). 
Use Checksum 
as ID 

Для использования контрольной суммы в качестве ID выберите 
этот пункт. 

 



 42 

5.3.5 Напряжения (Voltages). 
 

Таблица 5.4: Опции напряжений. 
Пункт Опция 
VDD Индицирует текущее значение напряжения VDD. MPLAB-ICD 

самостоятельно генерирует необходимое VPP=13в из напряжения, 
получаемого от Отлаживаемого устройства посредством 
использования преобразователя. 

VPP Индицирует текущее значение напряжения VPP. 
Update Обновление показаний текущих значений напряжений. 

 
Примечание переводчика: Для Модуля внутрисхемного отладчика с 
выполненной модификацией, описанной в файле etn21d.pdf (UPGRADING 
MPLAB ® -ICD Flash and Operating ICD below 4.5V). Показания этих полей буду 
неточными (завышенными), что однако не влияет на работоспособность 
устройства. 

 
5.3.6 Program Options. 

 
Таблица 5.5: Program Options 
Пункт Опция 
Start Address, 
End Address 

Начальный и конечный адрес блока памяти программ, который 
будет подвергаться записи, считыванию или проверке. 
 
Примечание: выбранный диапазон адресов не учитывается 
функцией стирания (Esare), которая стирает содержимое всей 
имеющейся у PIC16F87x памяти программ. 
 
Исходно, диапазон адресов устанавливается в максимально 
доступное значение для выбранного микроконтроллера. Для 
уточнения местонахождения файловых регистров и ячеек 
памяти программ, используемых ICD  в отлаживаемом 
микроконтроллере см. Раздел 1.5. 

Configuration 
Bits 

Программирование конфигурационных битов. Вы можете 
установить значения конфигурационных битов в верхней части 
Диалога ICD Options. 

ID Locations Программирование ячеек ID. Вы можете разрешить 
программирование ID ячеек в соответствии с установками в 
пункте  ID�s and Checksum Диалога ICD Options. 

EEPROM Data Для микроконтроллеров с данными в EEPROM позволяет 
программировать память данных EEPROM значениями, 
расположенными в окне EEPROM Memory. 

Erase All 
before Program 

Выбор этого пункта позволяет автоматически стирать 
содержимое кристалла после нажатия Program 
непосредственно перед программированием. 

Enable Debug 
Mode 

Выбор этого пункта разрешает программирование Отладочного 
Кода в микроконтроллер. Функция отладки будет включена 
каждый раз, после программирования. 
Если вы используете MPLAB-ICD только для внутрисхемного 
программирования отключите (очистите) этот пункт. 
Отладочный Код не будет дописываться после 
программирования и MPLAB-ICD не запустит функцию отладки. 
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5.3.7 Функциональные кнопки. 
 

Используйте функциональные кнопки для выполнения необходимых функций 
PIC16F87x в Отлаживаемом устройстве. Если вы указали диапазон адресов в 
разделе Program Oprions, запускаемые функции будут воздействовать только на 
указанный диапазон адресов (исключая функцию стирания - Erase). 

 
Таблица 5.6: Значения функциональных кнопок. 
Пункт Опция 
Blank Проверка микроконтроллера на стирание. 
Read Считывает область памяти, указанную в Program Options: 

память программ, конфигурационные биты, ячейки ID, и/или 
данные EEPROM. 

Program Программирует область памяти, указанную в Program Options: 
память программ, конфигурационные биты, ячейки ID, и/или 
данные EEPROM. Также подгружает Отладочный код в память 
программ если разрешен режим отладки (Debug Mode). 

Verify Проверяет область памяти, указанную в Program Options: 
память программ, конфигурационные биты, ячейки ID, и/или 
данные EEPROM. 

Erase Стирает все данные PIC16F87x, включая память, ID и 
конфигурационные биты. 

Download 
Operating 
System 

Загружает обновлённую версию прошивки MPLAB-ICD 
(операционной системы) в Flash микроконтроллера, 
установленного в Модуле MPLAB-ICD. 

Self Test Выполняет внутренний тест Модуля MPLAB-ICD. 
Примечание переводчика: Для Модуля MPLAB-ICD 
модифицированного в соответствии с документом etn21d.pdf 
(UPGRADING MPLAB ® -ICD Flash and Operating ICD below 
4.5V) может выводиться сообщение: 
�Incorrect MCLR pin high voltage. Check ICD pin1. 0xA7.� 
которое не влияет на работоспособность модуля. 

Def.Addr Восстанавливает Стартовый и конечный адреса в значения по 
умолчанию. 
 
Конечные адреса с включенным Debug Mode: 
• PIC16F873/874:0xEDF 
• PIC16F876/877:0x1EFF 
 
Конечные адреса в выключенным Debug Mode: 
• PIC16F873:0xFFF 
• PIC16F876/877:0x1FFF 
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5.4 Запуск программы. 
 

MPLAB-ICD работает в режиме реального времени или в пошаговом режиме. 
 

• Запуск в режиме реального времени происходит когда PIC16F87x в Переходнике 
MPLAB-ICD или в Демонстрационной или в Отлаживаемой плате вводится в 
режим Run MPLAB. 

• Режим пошаговой отладки может использоваться после остановки процессора 
командой Halt. 

 
5.4.1 Запуск в режиме реального времени. 

 
При запуске MPLAB-ICD в режиме реального времени команды выполняются 
также, как если бы процессор работал без режима отладки. PIC16F87x работает 
в режиме реального времени пока точка останова (break point) не остановит 
отлаживаемую программу или пока пользователь не выполнит функцию HALT. 

 
Для запуска в режиме реального времени щёлкните кнопку панели Run или 
используйте команду : Debug > Run > Run. Панель Debug имеет кнопки Run, 
Halt и Step для управления Отладчиком. При работе в режиме реального 
времени регистры отображаемые на дисплее не обновляются. 

 
5.4.2 Режим пошаговой отладки (Step Mode). 

 
Запуск режима пошаговой отладки происходит каждый раз при нажатии кнопки 
Step или выполнении команды Debug > Run > Step Пошаговый режим отладки 
позволяет проходить код одной инструкции за один раз, следя за ветвлениями 
программы и наблюдая за содержимым регистров после выполнения каждой 
инструкции (в соответствии с выбором в Upload Options Диалога MPLAB-ICD). 

 
Запуск Debug > Run > Animate позволяет автоматически выполнять 
последовательные шаги программы пока пользователь не остановит 
выполнение. Для просмотра изменений регистров в окнах Special Function 
Registers и окнах просмотра (Watch), используйте Animate. Animate выполняется 
несколько медленнее функции Run. 



 45 

5.5. Точки останова (Breakpoints). 
 

Точки останова - метки, на которых процессор останавливается после 
выполнения некоторого условия. MPLAB-ICD допускает следующие пути 
установки breakpints: 

 
• Остановка при совпадении адреса (Break on Address Match). 
• Остановка Пользователем (Break on User Halt). 

 
5.1.1 Break on Address Match (Остановка по совпадению 
адреса). 

 
Функция Отладки PIC16F87x допускает установку точки останова программы 
(breakpoint). Эта точка может устанавливаться на любой адрес памяти 
программ. Например, если точка останова установлена на адрес 005Ah, то 
процессор остановится после выполнения инструкции, расположенной по 
адресу 005Ah. 

 
Для установки точки останова выберите Debug > Break Settings. Также можно 
установить точку останова выбором адреса исходного кода в окне Program 
Memory или выбором строки кода окне исходного кода программы, кликая 
правой кнопкой мыши и выбирая в появившемся меню Break Point(s). 

 
5.5.2 Break on User Halt (Остановка пользователем). 

 
PIC16F87x работает пока вы не кликните кнопку Halt или пока не выберите 
Debug > Run > Halt. 

 

5.6 Как пользоваться MPLAB-ICD. 
 

MPLAB-ICD Помимо Внутрисхемного отладчика является ещё и Внутрисхемным 
программатором. Типичные функции используемые для отладки и проверки 
приложения обсуждаются в следующих разделах. 

 
5.6.1 Загрузка HEX файла для отладки. 

 
Загрузите HEX код в MPLAB-ICD используя команду File > Import > Import to 
Memory. Для информации о файловых регистрах и ячейках памяти программ, 
используемых ICD в своих целях см. Раздел 1.5. Ваш код не должен 
использовать этих ячеек памяти программ и файл-регистров. 

 
Примечание: Если вам необходимо указать значения для памяти данных 
EEPROM в вашем исходном коде - используйте адреса, начинающиеся с 
0x2100. 

 
Как только hex файл импортирован, Вы можете использовать меню Windows, 
чтобы открыть следующие окна: 

 
• Program Memory (Память программ). 
• Special File Registers (Регистры специальных функций). 
• File Registers (Файловые регистры). 
• EEPROM Memory (Память данных EEPROM). 
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5.6.2 Программирование Отлаживаемого 
микроконтроллера. 

 
В диалоге ICD Option проверьте установки: Тип Микроконтроллера (device), 
Осциллятор (oscillator) и конфигурационные биты (Configuration Bits). Далее, 
убедитесь, что Опции программирования (Program Options) корректны для 
вашего приложения. Если выбрано Enabled Debug Mode - Отладочный Код 
будет подгружен в PIC16F87x и он будет переведен после программирования в 
режим отладки. 

 
Кликните кнопку Program для программирования PIC16F87x в Переходнике 
MPLAB-ICD или Демонстрационной плате или Отлаживаемом устройстве. 
Программирование может занять пару минут. Время программирования может 
значительно увеличиться при пониженном  напряжении питания. 

 
Примечание: Отладочный Код - специальный код, подгружаемый в конец 
памяти программ Отлаживаемого микроконтроллера (см. Раздел 1.5). Он 
должен присутствовать для обеспечения возможности внутрисхемной отладки с 
использованием MPLAB-ICD. 

 
После этого, вы можете закрыть Диалог ICD Options, но не закрывайте Диалог 
MPLAB-ICD. Закрытие Диалога MPLAB-ICD отключит Отладчик. 

 
5.6.3 Функции Отладки. 

 
Вы можете использовать следующие функции MPLAB-ICD. Вы можете 
устанавливать только одну точку останова (breakpoint). 

 
• Run    - Запуск программы в режиме реального времени. 
• Reset   - Сброс PIC16F87x (MCLR Reset). 
• Break Settings - Установка точек останова. 
• Halt   - Остановка выполнения программы. 
• Step   - Одиночный шаг выполнения программы. 
• Animate   - Одиночные шаги, выполняемые автоматически 

(Анимация). 
• Change PC  - Изменение значения Программного счётчика (PC). 

 
5.6.4. Функции Модификации. 

 
Если вам необходимо модифицировать отлаживаемую программу, просто 
соберите (ассемблируйте) снова hex файл и загрузите его. Вы также можете 
использовать Диалог Modify для редактирования памяти программ перед 
загрузкой в PIC16F87x кнопкой Program. Если вы сделали это, объектный код 
сгенерированный из вашего исходного кода не будет совпадать с кодом в 
PIC16F87x. 

 
Вы можете использовать Window > Modify для изменения содержимого 
регистров, слов памяти программ или данных EEPROM. Выберите Window > 
File Registers и Window > Special Function Registers для просмотра 
внутренних регистров данных. 
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Глава 6. 
Опции Меню MPLAB-ICD. 

 
 

6.1 Введение. 
 

Эта глава дает детальную информацию о использовании меню опций MPLAB 
IDE  применяемых для ICD Отладчика. 

 

6.2 Основные моменты. 
 

Темы, затронутые в этой главе: 
 

• Меню File 
• Меню Debug 
• Меню Oprion 

 

6.3 Меню File (Файлы). 
 

Вместо использования проекта MPLAB IDE вы можете использовать команду 
File > Import > Import to Memory для загрузки hex файла в MPLAB-ICD. После 
загрузки в память, вы можете использовать пункты из меню Windows для 
просмотра памяти программ (program memory), специальных файл-регистров 
(special file registers), файловых регистров (file registers) и EEPROM. 

 

6.4 Меню Debug (Отладка). 
 

Для управления MPLAB-ICD доступны следующие функции. 
 

6.4.1 Run. 
 

Опция Run позволяет вам запустить программу в режиме реального времени 
или в пошаговом режиме. См. Раздел 5.6.3, в котором обсуждается каждая 
опция. 

 
6.4.2 Breakpoint Settings. 

 
Функция отладки MPLAB-ICD поддерживает единственную точку останова в 
одну единицу времени. Используйте команду Debug > Breakpoint Settings или 
нажмите кнопку <F2> для вывода Диалога Breakpoint Settings. Введите адрес 
ячейки на которую будет установлена точка останова (breakpoint). 
Альтернативно, вы можете выбрать ячейку памяти или строку исходного кода 
программы, на которую необходимо установить точку останова и нажать правую 
кнопку мыши (см. Раздел 5.5). 

 

6.5 Меню Options. 
 

Используйте Options > Development Mode для выбора MPLAB-ICD и укажите 
тип микроконтроллера для отладки. 
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Примечания: 
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Глава 7. 
Устранение неисправностей. 

 
 

7.1 Введение. 
Эта глава описывает некоторые общие проблемы, которые могут возникнуть при 
запуске MPLAB-ICD и пути решения этих проблем. 

 

7.2 Основные моменты. 
Темы, затронутые в это главе: 
 

• Общие проблемы. 
 

7.3 Общие проблемы. 
 

Communications cannot be established with MPLAB-ICD. 
 

Если вы не можете установить связь с MPLAB-ICD - выполните следующее: 
 

1. Убедитесь в наличии питания Демонстрационной или Отлаживаемой платы. 
MPLAB-ICD питается от источника питания Демонстрационной или 
Отлаживаемой платы. Также, если вы используете Демонстрационную плату 
убедитесь, что источник питания обеспечивает  требуемое значение питающего 
напряжения 9,0в и значение гарантируемого тока, требуемого для 
Демонстрационной или Отлаживаемой платы плюс ток потребления Модуля 
MPLAB-ICD (до 70 мА). 

2. Проверьте чтобы Переходник MPLAB-ICD был включен в Демонстрационную 
или Отлаживаемую плату корректно; например, все выводы переходника 
вставлены в панель и Переходник имеет правильную ориентацию. Также, 
убедитесь, что используется требуемый удлинитель контактов если вы 
используете Демонстрационную плату, иначе возможно одновременное 
подключение в обе панельки Демонстрационной платы. 

3. Убедитесь, что PIC16F87x вставлен в переходник MPLAB-ICD корректно (и что 
он вообще вставлен); например, все выводы вставлены в панель, и PIC16F87x 
имеет правильную ориентацию в панели. 

4. Убедитесь, что соединение между MPLAB-ICD и компьютером через кабель 
RS232 надёжно. 

5. Убедитесь, что соединение между Модулем MPLAB-ICD и отлаживаемым 
микроконтроллером (будь это Переходник MPLAB-ICD либо Демонстрационная 
или Отлаживаемая плата) надежно. 

6. Внимательно проверьте установки диалога MPLAB-ICD. Убедитесь, что вы 
корректно выбрали тип микроконтроллера, COM-порт, и скорость обмена. 

 
MPLAB IDE пытается установить связь с MPLAB-ICD при выборе Отладчика. 
Если связь не может быть установлена - Программирование или Отладка не 
будут выполняться. Также, при сбое произошедшем при попытке установки 
связи будет выдано сообщение об ошибке. Если при попытке соединения 
произошёл сбой, попробуйте снова после устранения проблемы. 

 
УСТРАНЕНИЕ 

• Убедитесь, что Источник питания подключен, и Светодиод Модуля MPLAB-ICD 
не мигает. Если Светодиод мигает - сделайте сброс Модуля кратковременным 
отключением питания. Затем, повторите выбор COM-порта MPLAB-ICD в 
Диалоге MPLAB-ICD. Светодиод должен прекратить мигать. 
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• Попробуйте подключить Модуль MPLAB-ICD к другому Последовательному 
порту компьютера. Если компьютер имеет 25-pin последовательный порт, вам 
необходим переходник из 25 на 9 контактов. 

• Убедитесь, что COM-порт корректно установлен и используется исключительно 
Отладчиком. Проверьте ресурсы Операционной Системы и убедитесь, что COM-
порт работает нормально и не имеет конфликтов с другими устройствами. 
Обычно это происходит, если у вас есть модем или другое неправильно 
сконфигурированное последовательное устройство. Обратитесь к Инструкции 
пользователя Windows или к другой доступной литературе. Вы можете 
попробовать удалить, переконфигурировать или отключить устройство, 
вызывающее конфликт, но делайте это только, если вы знакомы с этими 
процедурами. См. ниже для Windows 3.1 и Windows 95. 

• Некоторые системные ошибки вызваны несовместимостью драйверов. См. ниже 
для Windows 95. 

• Если у вас имеется COM-порт, но MPLAB IDE не позволяет его выбрать (опция 
серого цвета) вы можете назначить порт вручную редактированием файла 
MPLAB.INI. Типично это происходит, если в списке COM-портов имеется 
�разрыв� (т.е. вы имеете COM1, COM2 и COM4, но не имеете COM3). Поэтому 
вы можете решить эту проблему открыв MPLAB.INI (используйте команду 
�Поиск� для поиска расположения этого файла) и редактируя раздел [MPLAB-
ICD] и изменяя установку CommPort=1 на требуемый COM-порт. Это решение 
достаточно сложной проблемы, вызванной некорректной информацией от 
Windows о доступных портах через 16-битный драйвер. 

• Вы должны использовать штатный Коммуникационный драйвер Microsoft 
Windows соответствующий используемой вами версии Windows. Если вы 
используете Windows 3.10, найдите файл COMM.DRV в вашей 
\WINDOWS\SYSTEM директории. Этот файл Должен иметь время создания 
3:10a. Значение времени создания файла в этом случае определяет версию 
драйвера. Если вы используете Windows для рабочих групп - ищите файл, 
подобный описанному выше, но имеющий время создания 3:11a. Если этот 
файл отличается вам необходимо переустановить Windows или установить этот 
файл из другого источника. Эта проблема не проявляется в Windows 9x. 

• Убедитесь, что вы не используете коммуникационных драйверов Третьих 
производителей. Откройте файл SYSTEM.INI и в разделе [OPTIONS] найдите 
строку: 

 
COMM.DRV=COMM.DRV 

 
Если эта строка отличается от описанной - вы используете другой 
коммуникационный драйвер. 

 
Windows 3.1: 
 
Последовательная мышь использует COM-порт, также как и внешний модем. 
Внутренний модем имеет свой собственный COM-порт, поэтому, если вы имеете 
дополнительный COM-порт на PC - установите его так, чтобы не было 
конфликтов ни с мышью ни с модемом. 
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Windows 9x: 
 

Windows 9x требует особой осторожности при настройке COM-портов. Если вы 
подозреваете, что драйвер несовместим - попробуйте изменить Flow Control 
(Управление потоком данных) на Hardware (Аппаратное) и/или выключить FIFO 
для последовательного порта. В Windows 95 это выполняется через Панель 
Управления (Control Panel). Нажмите иконку Система (System). Далее, 
выберите вкладку Устройства (Device Manager) и кликните Порты COM и LPT 
(Port Settings). Если необходимо - раскройте секцию нажав на значок  �+�. 
Дважды кликните порт, к которому подключен MPLAB-ICD. Здесь вы сможете 
переключить Управление потоком данных (Flow Control) на Аппаратное 
(Hardware). Для отключения FIFO кликните кнопку Дополнительно (Advanced) 
и снимите метку с поля Использовать буферы FIFO (Use FIFO), и кликните 
OK. 

 
Если связь до сих пор не удаётся установить, свяжитесь с Microchip Customer 
Support как описано в General Information. 

 
Модуль MPLAB-ICD возвращает ошибку связи при выполнении команд Reset, 
Single Step, Halt или Run. 

 
Если используется Демонстрационная плата MPLAB-ICD, убедитесь, что 
джампер выбора типа осциллятора корректно установлен и микроконтроллер 
корректно запрограммирован. Если используется осциллятор убедитесь, что он 
установлен в панель. Эта проблема обычно приводит к тому, что 
микроконтроллер корректно программируется, и корректно входит в режим 
Отладки, но при исполнении команд reset, single step, halt или run - Модуль ICD 
выдает ошибку связи. 

 
Режим Отладки не работает. 

 
1. Закрытие Диалога MPLAB-ICD вызывает отключение ICD. Если вы закрыли этот 
Диалог, вы должны перезапустить MPLAB-ICD. Выберите Options > 
Development Mode, выберите MPLAB-ICD и нажмите OK. 

2. Отладочный код должен быть запрограммирован в микроконтроллер перед 
запуском режима Внутрисхемной отладки. Выберите Enable Debug Mode из 
Диалога Options для разрешения программирования Отладочного кода в 
Отлаживаемый микроконтроллер. 

 
Примечание переводчика: Эта ошибка очень часто встречается у начинающий 
пользователей MPLAB-ICD. 

 
В режиме пошаговой отладки программа работает слишком медленно. 

 
Проверьте опции загрузки (upload) Диалога MPLAB-ICD. Скорее всего вы 
установили загрузку слишком большого количества данных; например используя 
установку �All Registers� вы можете получить приблизительно 5 секундную 
задержку между шагами. Для уменьшения этой задержки выберите режим 
загрузки меньшего количества данных. 

 
В режиме пошаговой отладки программа работает слишком быстро или 
некоторые важные регистры не обновляются. 

 
Проверьте опции загрузки (upload) Диалога MPLAB-ICD. Если вы установили 
�Minimum� данных, пауза между шагами будет значительно меньше, чем при 
загрузке всех регистров �All Register� Если вы не получаете всех необходимых 
вам данных - убедитесь, что вы выбрали корректно тип(типы) загружаемых 
регистров. 

 
После выполнения останова (Halt), одиночного шага программы (Single Step) или 
остановки на точке останова программы (breakpoint), кажется что MPLAB-ICD 
�подвисает�. 
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Проверьте опции загрузки (upload) Диалога MPLAB-ICD. Если вы загружаете 
большое количество данных (например, �All Registers�) вы можете получить 
около 5 секунд задержки между шагами. Для уменьшения этой задержки 
выберите опцию с меньшем количеством загружаемых данных. 

 
Следующие I/O выводы не функционируют корректно: RB3, RB6 и/или RB7. 

 
Эти выводы резервируются для осуществления 
Программирования/Внутрисхемной Отладки. Более подробная информация в 
Разделе 1.5. 
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Приложение A. 
Аппаратная часть MPLAB-ICD. 

 
 

A.1 Введение. 
 

Аппаратная часть MPLAB-ICD включает Модуль MPLAB-ICD, Переходник и 
Демонстрационную плату. 

 

A.2 Модуль и Переходник MPLAB-ICD. 
 

Модуль MPLAB-ICD и Переходник используются для выполнения Функций ICD 
на Демонстрационной плате или плате Отлаживаемого устройства. 

 
A.2.1 Спецификации Напряжений и потребляемого тока. 

 
Переходник MPLAB-ICD питается от Отлаживаемого устройства напряжением в 
диапазоне от 3,0в до 5,5в. Значения потребляемого тока различных режимов 
работы при различных напряжениях следующие: 
Режим 
работы 

5 в. 3 в. 

Debug 35 мА (максимально) 20 мА (максимально) 
Run 40 мА 25 мА 

Verify 60 мА 50 мА 
Program 60 мА 50 мА 

 
 

A.2.2 Монтажная и Принципиальная Схемы. 
 

Этот раздел содержит монтажные и принципиальные схемы Модуля MPLAB-ICD 
и Переходника. 

 

 
Рисунок A.1: Монтажная схема Модуля MPLAB-ICD. 
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Рисунок A.2: Принципиальная схема Модуля MPLAB-ICD, часть 1 
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Рисунок A.3: Принципиальная схема Модуля MPLAB-ICD, часть 2 
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Рисунок A.4: Принципиальная схема Модуля MPLAB-ICD, часть 3 
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Рисунок A.5: Монтажная схема Переходника MPLAB-ICD. 
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Рисунок A.6: Принципиальная схема Переходника MPLAB-ICD. 
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A.3 Демонстрационная Плата MPLAB-ICD. 
 

Демонстрационная плата MPLAB-ICD - простая демонстрационная плата, 
поддерживающая микроконтроллеры семейства PIC16F87x. Плата может быть 
использована как автономно, с заранее запрограммированным 
микроконтроллером, так и совместно с Модулем MPLAB-ICD и Переходником. 
Приводится пример программы для демонстрации уникальных элементов 
микроконтроллеров. Хотя и 40-pin и 28-pin панели установлены для обеспечения 
возможности использования обоих вариантов исполнения микропроцессоров, 
допускается использование только одного процессора в одну единицу времени.  

 
A.3.1 Панели процессора. 

 
Доступные панели: 

 
• 40-pin панель для PIC16F871/874/877. 
• 28-pin панель для PIC16F870/872/873/876. 

 
Дополнительно, 40- и 28-pin панели подключаются через соответствующий 
удлинитель выводов. Просто установите требуемую панель на 
Демонстрационную плату и вставьте Переходник MPLAB-ICD. Без 
использования соответствующего удлинителя выводов, Переходник будет 
подключен одновременно к обоим панелям, и не сможет корректно работать. 
Или можете просто вставить микроконтроллер непосредственно на 
Демонстрационную плату и использовать прямое подключение к Модулю 
MPLAB-ICD через модульный разъем. 

 
A.3.3 DIP-переключатели. 

 
В блоке SW3 имеется Восемь переключателей. Если все переключатели 
установлены в положение �ON�, то каждый из восьми красных светодиодов 
подключен к соответствующему выводу порта PORTC. 

 
A.3.4 Источник питания. 

 
Модуль MPLAB-ICD питается напряжением VDD Отлаживаемого устройства, с 
напряжением в диапазоне от 3,0 вольт до 5,5 вольт (и соответствующим током 
потребления). Если вы пользуетесь программатором PICSTART Plus, вы можете 
использовать его источник питания для питания Демонстрационной платы. 

 
A.3.5 Подключение ICD. 

 
Модульный разъем, находящийся рядом с разъемом источника питания может 
быть использован для непосредственного подключения Демонстрационной 
платы к Модулю MPLAB-ICD без использования Переходника MPLAB-ICD. 
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A.3.6 Последовательный порт RS-232. 
 

Микросхема формирователя уровней RS-232 может быть самостоятельно 
установлена обеспечения подключения к хосту RS-232 через разъем DB9. Порт 
сконфигурирован как DCE, и может быть подключен к компьютеру используя 
прямой проходной кабель (удлинитель), отличающийся от Нуль-Модемного 
кабеля. Схема формирователя должна быть смонтирована пользователем: 

 
• U4  - ADM232A (Analog Devices), MAX232A (Maxim) или аналог. 
• R14-R19 - Резисторы 330 Ом, 1/8Вт (0,125Вт) 
• C7-C11 - Конденсаторы емкостью 0,1 мкФ. 

 
A.3.7 Кнопки. 

 
Две кнопки обеспечивают следующие функции: 

 
• MCLR для сброса процессора. 
• Переключатель с активным �0�, подключенный к выводу RB0. 

 
A.3.8 Опции Осциллятора. 

 
Вы можете использовать схему RC-осциллятора, или вставить генератор в 4-pin 
панель. Убедитесь, что джампер (JP1) установлен правильно. 

 
• Панель предназначена для установки тактового генератора - используйте 
генератор с частотой от 32 кГц до 20МГц. 

• RC цепочка. Частота, генерируемая с резистором сопротивлением 4,7 кОм и с 
конденсатором емкостью 20 пФ попадает в диапазон от 3,5 МГц до 6 МГц в 
зависимости от уровня напряжения питания и температуры окружающей среды. 

 
A.3.9 Аналоговый ввод. 

 
Движок потенциометра наминалом в 1 кОм подключен последовательно, через 
резистор сопротивлением 470 Ом (для защиты микроконтроллера, если его 
вывод RA0 оказался сконфигурирован на выход). Напряжение на движке 
потенциометра может изменяться от VDD до GND позволяя имитировать 
аналоговые напряжения для PIC16F87x. 

 
A.3.10 Монтажные и Принципиальные схемы. 

 
Этот раздел содержит Монтажные и Принципиальные схемы на 
Демонстрационную плату MPLAB-ICD. 
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Рисунок A.7: Монтажная схема Демонстрационной платы MPLAB-ICD. 
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Рисунок A.8: Принципиальная схема Демонстрационной платы MPLAB-ICD, часть #1. 
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Рисунок A.9: Принципиальная схема Демонстрационной платы MPLAB-ICD, часть #2. 
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Рисунок A.10: Принципиальная схема Демонстрационной платы MPLAB-ICD, часть #3. 
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Рисунок A.11: Принципиальная схема Демонстрационной платы MPLAB-ICD, часть #4. 

 
 
 
 
 
 
 
 
 


